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Overview

This document describes the database views that you can use to run reports in Cloud Service Automation (CSA).

Included is a database view that allows you to run a report showing contents of the CSA audit log. This document also

provides an example of how to install, configure, and use third-party reporting software (from Jaspersoft Corporation) to

run CSA reports.

Prerequisites

CSA supports databases from Oracle, Microsoft SQL, and PostgreSQL for reports. Before you can run reports, you must

create a read-only database user (and a role, if using Oracle) specifically for reporting purposes, and then you must

specify its username and password during the CSA installation or upgrade. If you did not add this user during installation

or upgrade, see the Cloud Service Automation Configuration Guide for instructions on how to add this user.

Database Views for Standard Reports

CSA provides some commonly-needed information for a sequence-based model through the (non-materialized)

database views for reporting. A read-only database user will have access to these views, which they can use to design

reports.

Note: For audit reports, see the Database View for Audit Reports section.

The following table lists each view and some filters (list of values) that read-only users can use in a report designer.

Table 1. List of Database Views

Number View name

1 RPT_RSC_CAPACITY_V

2 RPT_USER_SUBSCRIPTION
Vv

3 RPT_SUBSCR_RSC_V

4 RPT_SUBSCR_OPTS_V

5 RPT_RESOURCE_UTILIZATI
ON_V

1 RPT_PAY_PER_USE_METE
RV

Filters (list of values)

RPT_LOV_PROVIDER_V
RPT_LOV_PROV_POOL_V

RPT_LOV_ORG_V
RPT_LOV_ORG_USR_V
RPT_LOV_CAT_OFFR_V

RPT_LOV_PROVIDER_V
RPT_LOV_PROV_POOL_V

RPT_LOV_ORG_USR_V
RPT_LOV_PROVIDER_V

RPT_LOV_PROV_POOL_V

N/A

Description and comments

Within each Pool, list Resource Type,
Quantity Used, Quantity Remaining, and
Units.

Group by Organization and by User
consuming the subscription (filter by
organization, user, and offering). Group
information must be fetched from the
view. The group here is the 'Owned By'
group.

Group by Provider and by the Resource
Pools defined within it (with subscription
details).

Show the options and option prices for
subscriptions.

Provide information on resource utilization
for subscriptions.

List the maximum operating system
instances (OSI) being used in CSA active
subscription for each organization in the
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last 30 days.

2 RPT_LICENSE_OSI_USAGE | N/A List the total OSI being using in CSA active
\" subscription for the CSA instance.

RPT_RSC_CAPACITY_V View
This view provides a list of providers and pools and their available capacity and utilization.

Table 2. RPT_RSC_CAPACITY_V View

Field name (in the view)
PROVIDER_ID
PROVIDER_NAME
PROVIDER_TYPE
SERVICE_ACCESS_POINT
RESOURCE_POOL_ID
RESOURCE_POOL_NAME
KNOWN_TO_PROVIDER_AS
RESOURCE_TYPE
AVAILABILITY
AVAILABLE_TO_CSA

USED_BY_CSA

Functional description

Identifier of the resource provider.

Name of the resource provider.

Type of resource provider.

Access point URL for the provider.

Identifier of the resource pool.

Name for the resource pool.

Name of the resource pool used by the provider.
Type of resource (such as CPU or Storage).
Category to indicate if the resource is available.
Quantity of the resource that is available to CSA in the pool.

Quantity of the resource that has been used by CSA from this pool.

RPT_USER_SUBSCR_V View
This view provides detailed information for subscriptions (excluding the Option selection and Pricing information).

Table 3. RPT_USER_SUBSCR_V View

Field name (in the view) Functional description
SUBSCRIPTION_ID Identifier of the subscription.
SUBSCRIPTION_NAME Name of the subscription as displayed.

SUBSCRIPTION_START_DATE Start date of the subscription.

SUBSCRIPTION_END_DATE End date of the subscription.

SUBSCRIPTION_OWNER_GROUP Name of the group that owns this subscription (applicable only for

subscriptions owned by a group).

SUBSCRIPTION_STATUS Status of the subscription.

Page 4



REQUESTED_BY_USER_ID
REQUESTED_BY_USER
REQUESTED_BY_USER_EMAIL
ORGANIZATION_ID
ORGANIZATION_NAME
CATALOG_ID
CATALOG_NAME

SERVICE_OFFERING_ID

SERVICE_OFFERING_NAME

RPT_SUBSCR_RSC_V View

Identifier of the user requesting the subscription.

Name of the user requesting the subscription.

Email address of the user requesting the subscription.

Identifier of the organization to which this subscription belongs.
Name of the organization to which this subscription belongs.
Identifier of the catalog to which this subscription belongs.
Name of the catalog to which this subscription is published.

Identifier of the service offering for which this subscription was
submitted.

Name of the service offering for which this subscription was submitted.

This view provides information about the Resource Provider and Resource Pool used by a subscription.

Table 4. RPT_SUBSCR_RSC_V View

Field name (in the view)
SUBSCRIPTION_ID
RESOURCE_PROVIDER_ID
RESOURCE_PROVIDER_NAME
PROVIDER_ACCESS_POINT_URI
RESOURCE_RPOVIDER_TYPE
RESOURCE_POOL_ID

RESOURCE_POOL_NAME

RPT_SUBSCR_OPTS_V View

Functional description

Identifier of the subscription.

Identifier of the resource provider.

Name of the resource provider.

Access point URI of the resource provider.
Type of the resource provider.

Identifier of the resource pool.

Name of the resource pool.

This view provides the options and option prices for subscriptions.

Table 5. RPT_SUBSCR_OPTS_V View

Field name (in the view)
SUBSCRIPTION_ID
OPTION_MODEL_ID
CURRENCY_DISPLAY_NAME

RECURRING_PERIOD_DISPLAY_NAME

Functional description

Identifier of the service subscription.

Identifier of the option model.

Display name of the currency used in the option model.

Display name of the recurring period used in the option model.
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Field name (in the view)
L1_OPTION_SET_ID
L1_OPTION_SET_NAME
L1_OPTION_SET_DISPLAY_NAME
L1_OPTION_ID
L1_OPTION_NAME
L1_OPTION_DISPLAY_NAME

L1_OPTION_SELECTED

L1_INITIAL_PRICE
L1_RECURRING_PRICE
L2_OPTION_SET_ID
L2_OPTION_SET_NAME
L2_OPTION_SET_DISPLAY_NAME
L2_OPTION_ID
L2_OPTION_NAME
L2_OPTION_DISPLAY_NAME

L2_OPTION_SELECTED

L2_INITIAL_PRICE
L2_RECURRING_PRICE
L3_OPTION_SET_ID
L3_OPTION_SET_NAME
L3_OPTION_SET_DISPLAY_NAME
L3_OPTION_ID
L3_OPTION_NAME
L3_OPTION_DISPLAY_NAME

L3_OPTION_SELECTED

L3_INITIAL_PRICE

Functional description

Top-level option set ID.

Top-level option set name.
Top-level option set display name.
Top-level option ID.

Top-level option name.

Top-level option display name.

'Y' if the top-level option is selected.

'N"if the top-level option is not selected.
Initial price of the top-level option.
Recurring price of the top-level option.
Child-level option set ID.

Child-level option set name.

Child-level option set display name.
Child-level option ID.

Child-level option name.

Child-level option display name.

'Y' if the child-level option is selected.
'N' if the child-level option is not selected.

Initial price of the child-level option.
Recurring price of the child-level option.
Grandchild-level option set ID.
Grandchild-level option set name.
Grandchild-level option set display name.
Grandchild-level option ID.
Grandchild-level option name.
Grandchild-level option display name.

'Y' if the grandchild-level option is selected.

'N' if the grandchild-level option is NOT selected.

Initial price of the grandchild-level option.
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Field name (in the view)

L3_RECURRING_PRICE

Functional description

Recurring price of the grandchild-level option.

RPT_ROESOURCE_UTILIZATION_V View

This view provides the information on resource utilization for subscriptions.

Table 6. RPT_RESOURCE_UTILIZATION_V View

Field name (in the view)
SUBSCRIPTION_ID
SUBSCRIPTION_NAME
COMPONENT_ID
COMPONENT_NAME
RESOURCE_POOL_ID
RESOURCE_POOL_NAME
PROVIDER_ID
PROVIDER_NAME
MEASURABLE_PROPERTY_NAME
RESOURCE_TYPE
RESOURCE_UNIT

UTILIZATION

RPT_PAY_PER_USE_METER_V

Functional description

Identifier of the subscription.

Name of the subscription.

Identifier for the service component.

Name of the service component.

Identifier of the resource pool.

Name of the resource pool.

Identifier of the provider.

Name of the provider.

Name given to the measurable property.

Type of resource for this measurable property.
Measuring unit of this resource in the measurable property.

Quantity of this resource that has been used by this subscription in this
pool.

This view provides a list of the maximum operating system instances (OSI) being used in CSA active subscriptions for

each organization in the last 30 days.

Table 7. RPT_PAY_PER_USE_METER_V View

Field name (in the view)

START_DATE

END_DATE

ORGANIZATION

DEPLOYED_OSI|_COUNT

Functional description

Start date from which the OSI usage is determined. By
default, this is 30 days prior to the current date.

End date to which the OSI usage is determined. By default,
this is the current date.

Name of the organization to which the OSI usage belongs.

OSI count consumed by the organization.
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MAXIMUM_QOSI_LIMIT Cumulative count of purchased OSI.

RPT_LICENSE_OSI_USAGE_V

This view provides a list of the total operating system instances (OSI) being used in CSA active subscriptions for the CSA
instance.

Table 8. RPT_LICENSE_OSI_USAGE_V View

Field name (in the view) Functional description

START_DATE Start date from which the OSI usage is determined. By
default, this is 30 days prior to the current date.

END_DATE End date to which the OSI usage is determined. By default,
this is the current date.

DEPLOYED_OSI_COUNT OSl count consumed by the organization.

MAXIMUM_OSI_LIMIT Cumulative count of purchased OSI.

Database View for Audit Reports

CSA provides auditing capability by creating an audit event record in the CSA database for several important events that
occur during the lifetime of a running instance of CSA. Each audit event has a Classification Code and Operation Type
attribute, as indicated below. CSA captures audit log information for the following events:

User Authentication to CSA and the Marketplace Portal
— For every successful login and unsuccessful login attempt, an audit event record is created.
- Classification Code - Authentication
- Operation Type - Login
User Authorization
— If an unauthorized user access is identified, an audit event record is created.
- Classification Code - Authorization
— Operation Type - Access
e (CSA Service Start and Stop
An audit event record is created every time the CSA service is started and stopped.
Classification Code — Server Management
Operation Type — Server Start, Server Stop
e Transactional Events Involving CSA Artifacts

Whenever a CSA artifact is created, updated or deleted, an audit event record is created. CSA artifacts include Service
Design, Service Offering, Organization, Catalog, Service Request, Subscription, Approval Process, and Service Instance.

Classification Code — ‘Create Update Delete’
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Operation Type — Create, Update, Delete

e Change in Service Offering Price

An audit event record is created when pricing for a service offering changes.

Classification Code — ‘Create Update Delete’

Operation Type — Create, Update, Delete

e Transactional events involving the LDAP access point

Whenever the LDAP access point of an organization is created or updated, an audit event record is created.
Classification Code — ACCESSPOINT

Operation Type — Create, Update

The audit information can be accessed using the following database view:
e RPT_AUDIT EVENT V

Like the other CSA reporting views, a read-only database user will have access to this view, which they can use to design
audit reports in a report designer.

Note: See the Audit Report Examples section for example queries for audit reports.

Note: Audit event data can be purged if desired by running the Database Purge tool. See the Cloud Service Automation
Configuration Guide for more information.
RPT_AUDIT_EVENT_V View

This view provides information from the CSA audit log.

Table 9. RPT_AUDIT_EVENT_V View

Field name (in the view) Functional description
CREATED_ON Timestamp when the audit event was created.
MODIFIED_BY_ USERNAME User name of the user who accessed the CSA system at login and

created, modified or deleted the CSA artifacts or created or modified
the LDAP access point.

USER_ORGANIZATION_NAME Organization to which the user accessing the CSA system belongs.
ARTIFACT_ID Unique ID of the artifact being created, updated, or deleted.
ARTIFACT_NAME Name of the artifact at the time the audit event was generated. In case

of an LDAP access point transaction, this is the organization to which
the user accessing the CSA system belongs.

ARTIFACT_TYPE Type of artifact being created, updated, or deleted.

AUDIT_CLASSIFICATION Audit Classification Code. See Database View for Audit Reports for
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AUDIT_OPERATION

ORIGINATING_SERVER

SERVER_TYPE
DESCRIPTION

AUTHENTICATION_USER

ORIGIN_IP

possible values and how they are used.

Audit Operation Type. See Database View for Audit Reports for
possible values and how they are used.

Server name from where the logon attempt was made. This attribute is
currently used only for the authentication event.

Currently used only for authentication event and set to ‘IDM.’
Description of the audit event.

The user used for basic authentication of a REST call. For Legacy CSA
3.x API calls, this is the user used for HTTP basic authentication of a
REST call. For Consumer (Consumption) API calls, this is the user for
which the X-Auth-Token HTTP header has been provided (the name of
the HTTP header may be different if you customized the xAuthToken
configuration property in csa.properties; see the Cloud Service
Automation Configuration Guide for more information about this
property). For Management (Consumption) API calls, this information
is not captured (this field is empty).

The IP address from which a Legacy CSA 3.x or Consumer
(Consumption) API call originates. Only Consumer APIs that include the
onBehalf parameter in the Response Content Type capture the IP
address. For the remaining Consumer APlIs, this information is not
captured (this field is empty). For Management (Consumption) API
calls, this information is not captured (this field is empty).

If the csa.origin.ip.header property is configured in the
csa.properties configuration file, CSA captures the originating IP
address from the custom HTTP header defined by the property.

If the csa.origin.ip.header property is not configured, CSA uses the X-
Forwarded-For HTTP header as the originating IP address.

If the csa.origin.ip.header property is not configured and the X-
Forwarded-For HTTP header is not set, CSA fetches the originating IP
address from the incoming request.

For more information about the csa.origin.ip.header property, refer to
the Cloud Service Automation Configuration Guide.

Use Jaspersoft Software to Create and Deploy Reports

This section uses Jaspersoft software as an example of how to install, configure, and use third-party reporting tools to

create and deploy CSA reports.

Install Jaspersoft iReport Designer and Create Reports

iReport Designer is the report development tool for JasperReports and JasperReports Server.

1. Install iReport Designer by following the instructions at:

http://sourceforge.net/projects/ireport/
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http://sourceforge.net/projects/ireport/

2. StartiReport Designer.

The New file dialog box appears.

— A report is used to display values from a data source like a database or an XML file.
. Select a starting point for your report or choose the wizard to guide you.

“\ Report -
P g O™ ""I

* Colfoe Titk:

i Style

Coffee Coffee Landscape

Ty Chart Theme

Resource Bundle

w

l
ﬁ Other file Types
™MZ

|

3 B Tyl ;I
?E ] _J— | | Open this Template Launch Report Wizard | Cancel I

Click to select a report template.
Click Open this Template.

The Name and location dialog box appears.
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mr{ew

Steps Name and location

1. Choose Template
2. Name and location
3. Finish

Report name: ISubscriptionByProvider

Location: IC:'l,Users'l,Administrator\Desktop Browse I

File: |I,Users\Administrator'\Desktop'q.SubscriptionByProvider.jrxml

< Back I Next = I Einish Cancel Help

Enter the report name into the Report name field.

The default location in the Location field is your desktop. You can click the Browse button to select another location
to store the template. The .jrxml file is always saved to the same folder as the template.

Click Next.

The Query dialog box appears.
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Steps Query

Zhoose Template
Mame and location

1

2

3. Query

4, Fields Ernpty datasource =
2

&

Canneckions | Daka Sources

Group by,
Finish

< Back | Mext = I Finish Cancel Helm

Do one of the following.
e Select an existing data source from the Connections / Data Sources pull-down menu.

e Click New to create a new connection/data source, if no connections/data sources are available.

If you clicked New, the Datasource dialog box appears.
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“sa=" Datasource

Select the datasource bype

Diatabase IO i y
MetBeans Database JDBC connection
%ML file datasource

JavaBeans set datasource

File C5% datasource
JRDataSourceProvider

Zuskam JRDataSource

Empty data source

Hibernate connection

Spring loaded Hibernate conneckion
EJBOQL conneckion

AMLA Server

Mondrian OLAP conneckion

Cuery Executer mode

Microsoft Excel (xls) data source
Microsoft Excel 2007 (xlsx) data source
MongoDE Conneckion

Femote =ML file datasource

150N datasource

Hadoop Hive Connection

Sample Database Connection

Tiesk || Mext = I Zancel

Select the Database JDBC connection data source type.

Click Next.

The Database JDBC connection dialog box appears.
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=
|

L -

7™
L

7

=" Database JDBC connection

Marne I

IDBC Driver I PostgresQL (org.postgresgl.Driver) LI

IDEC URL del:uc:pu:ustgresql:,l',l'Iu:u:th-:ust:5432,I'DatabaseName

- Credentials

Usernarme I

Passwiord I

[T Save passward

ATTEMTION! Passwaords are stored in clear text, IF you donk specify a
v, password now, iReport will ask you for one only when required and will not
sawve ik,

Test | Save I Cancel

Fill in the following dialog box fields:
e Name
e IDBC Driver
Select the correct driver for your database.
e JDBC URL
e Username
e Password

If the driver for your database is not available, it appears in red, which means that it is not in the classpath.
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&

| —
s Database JDBC connection
MName [CSA_test

JDBC Driver | PostgreSQL (org.postgresql.Driver)| L.'

MS SQLServer (net.sourceforge. jtds.jdbc. Driver) -
MS SQLServer (com.merant.datadirect. jdbc.sqlserver. SQLServerDrive

~CredentialgySQL (org.gjt.mm.mysql.Driver)
MySQL (com.mysql.jdbc. Driver)

JDBC URL

Username [

Password: [PostgreSQL (org.postgresL Driver class ovacle, jdbe. driver. OracleDriver
Sybase (com.sybase. jdbc2 non found in the classpath! !

Vertica (com.vertica.Driver v

ATTENTION! Passwords are stored in clear text. If vou dont specify a
+ . password now, iReport will ask you for one only when required and will not
save it,

Test Il Save I Cancel

If the driver is not available, select Tools > Options > Classpath > Add JAR from the menu bar.

Add the driver to the classpath as in the following dialog box.
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% B a

Editor Fonts & Colors

R

iRepork General

Export ootions | JasperReports Properties

Miscellaneous

Keymap

I Heartheat |

JasperReports Server Repository

Quety Executers

Add JaR

General Classpath I Fonts Wigwers ‘Wizard Templates | Zompilation and execution
Classpath
Path Relnadable
Cs\Program Files (x86))JaspersoftiiReport-3.5. Dlireportimodules extihsgldb-1.5. . [}
Zs\Program Files (x56))JaspersoftiiReport-3.5. Dlireportimodules ext jasperrepor., [}
Cs\Program Files (x86))JaspersoftiiReport-3.5. Dlireportimodules) ext jasperrepor., [}

Add Folder |

Eﬁndd JAR(s) / path to the classpath

Lok in: I ]

LI j‘ 8 -

Remove |
Maove up |

TMove down |

. reportRead?. html_files

=] cherry.ipg

=] coffee.jpg

W] coffee_stain.png

ojdbcS.jar

ojdbcS_g.jar

ojdbcSdms. jar
ojdbcSdms_g.jar

EEEE

ojdbce_g.jar
ojdbcadms. jar

EEE]E

ojdbcadms_g.jar

|| report_Resource_Capacity . jasper
IE repart_Resource_Capacity jrxml

| 7| reportRead1.html

|| reportReadl. jasper

lﬁ reportRead] . jrxml

|| reportReadl.pdf

|| report-ReadOnly-test. jasper
@ report-ReadOnly-test, jrxml
] simplefan. jar

File name: Injdbce.jar

Cpen I

Files of bype: |n|| Files

Cancel

Cancel

E3

Click Test to validate your username and password with the database.

A popup appears if the test is successful.
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-

R
pa—
\-“ Datahase JDBC conhection

Marme ICS.ﬁ.-Test

JDEC Driver I Cracle {oracle. jdbc. driver . CracleDriver) LI

IDEC URL del:u::Dracle:thin:@lucalhust: 15211234

~Credentials

sernarnne II:SEILISE-'I’

Passwiord I*******

I__' <]
ATTENTIC Fy a

1, password d will nok
save it

Connection kest successFull

Test | Save I Cancel

Click OK.
Click Save.
The Query dialog box appears.
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Steps Query

1. Choose Template

= et end location Connections | Data Sources

3. Query

4, Fields Icsal LI e
5, Group by...

6, Finish Query (S0L)

select *
from csauser RPT_SUBSCR_RSC_V rsub, csauser RPT_USER _SUBSCRIPTION Y usub
where rsub.subscription_id = usul:u.sul:uscriptinn_id|

Design query | ! Load query | [5] Save query |

< Back | Mext = I Eimish Cancel Helq

Click Design query.

Use the query editor to design a query and click OK.

Note: See the Audit Report Examples section for example queries for audit reports.
Click Next.

The Fields dialog box appears.
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Steps

Fields

Choose Template
Mame and location
Query

Fields

Group by...

Finish

L=y B N N
o oy Y e A

TION_ID
RESOURCE_PROVIDER_ID
RESOURCE_PROVIDER_TYPE
RESOURCE_POOL_ID
RESOURCE_POOL_NAME
SUBSCRIPTION_MAME
SUBSCRIPTION_START_DATE
SUBSCRIPTION_END_DATE
SUBCRIPTION_OWNER_GROUP
SUBSCRIPTION_STATUS
REQUESTED_BY_USER_ID
REQUESTED_BY_USER
REQUESTED_BY_USER_EMAIL
ORGANIZATION_ID
ORGANIZATION_NAME
CATALOG_ID

CATALOG_NAME

RESOURCE_PROVIDER _NAME
ROVIDER _ACCESS_POINT_URI

< Back | Mext > | Eiristy | Cancel Help I

Use the arrow buttons to select the fields to appear in the report.

Click Finish.

The template appears in the Designer format.

(Optional) Rearrange the order of the columns (fields) in the report and modify the formatting (such as right- or left-
justified) for the title, field, and column names.

Preview the report by clicking the Preview tab.

Following is a preview of a report.

L, ProvidersubcriptionReport. jrxml x]

Designer I ML

| eEa|w «» [ (DEM@alie ¥ &

Access Point

Subscriptions by Provider

Provider Type Resource Pool

Subscription Start Date End Date

https:/Mlocalhost:443 VMware vCenter RnD Pool Windows server subs 2013-11-01 08: null
00:00.0

https:/Mlocalhost:443 VMware vCenter RnD Pool QA Subscription 2013-11-01 08: null
00:00.0

https:/Mlocalhost:443 VMware vCenter RnD Pool Snow White Program 2013-11-01 08: null
00:00.0

http://test VMware vCenter  Finance Pool

Customer POC #156 2013-11-01 08: null
00:00.0
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Install and Configure JasperReports Server for Use with CSA

1. Install JasperReports Server by following the instructions at:
http://community-static.jaspersoft.com/sites/default/files/docs/jasperreports-server-install-guide.pdf
Go to the JasperReports Server login page at:
http://localhost:8082/jasperserver/login.html
Enter the following login credentials:

User ID: jasperadmin

Password: jasperadmin

Login

User ID:

jasperadmin

Password:

0000000000

Show locale & time zone

Need help logging in?

Click View > Repository.

Right-click the root/Data Sources folder and select Add Resource > Data Source.
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http://community-static.jaspersoft.com/sites/default/files/docs/jasperreports-server-install-guide.pdf
http://localhost:8082/jasperserver/login.html

€ > C [ localhost:8082/jasperserver fflow.html?_flowld=searchFlow

aJASPERSOFT #& Library Yiew, Manage,

£l Folders

Repository

lfl-_u' root

Run Edit Open | Copy Cut Paste Delete

Analysis Components '
=~ ) O Marne
Content Files
Data Sources e
Trosges Add Folder ~server Repository SQL data source
Input data Type Add Resource » Data Saurce
Sl Reports Copy Datatype

@l CSA_Report  Cut File » urce

Interactive Delete Input Control

Samples Permissions. .. JasperReport
System Properti Properties Content Resource
(Hl Themes List of Values

Export

Mondrian XML& Source
OLAP Client Connection
OLAP View

Query

The Add Data Source dialog box appears.
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£J JASPERSOFT  #& Library View, Manage,

Add Data Source

Set Data Source Type and Properties

First, select the type of data source you wish to add, then enter the required property values.

Type: |JDBC Data Source =

Mame (required):

Resaurce 1D {required):

Description:

JDBC Driver:

IPostgreSQL {org.postgresql.Driver) j Edit Driver...

Host {required):

localhost

Port {required):
S432

Database (required):

dbname

URL {required):
jdbeipostgresql:/flacalhost: 5432/dbname

User Mame (required):

jasperadmin

Password:

Time Zone:
|Use database setting ;l

Hint: Do not change the tirne zone setting unless vou know the database tirmestarnp data is incorrech,

Save Location (required):

fdatasources

Enter information into the following fields:

o Type of data source
Select JDBC Data Source (this is required for the databases supported by CSA).
e Name of your choice
e Resource ID of your choice
o (Optional) Description
o IDBC Driver of the installed database

If the driver is not in the list, you can add the Java archive (JAR) file by using the Edit Driver option.
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e Host where the database is installed
Enter localhost if the database is on your local system.

Enter the IP address of the system, if your database is installed on another system. (To find the hostname, log in
to that system and enter the hostname command from a command prompt.)

e Port number
e Database name
e URL
Using your hostname and database name, modify the URL as follows:
jdbc:postgresql://<host>:5432/<dbname>
By default, the URL is jdbc:postgresql://localhost:5432/dbname.
e User Name
Enter the same username as for JasperReports Server.
e Password
Enter the same password as for JasperReports Server.

Click Save to save the data source.

Deploy a Report in JasperReports Using the iReport Designer
In this procedure, you deploy a report to the server. First, you connect iReport to the repository.

1. Select Window > JasperServer Repository.
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[Mireport 3.5.0

File Edit Formak Wiew Preview | Window Tools  Help

2

| Report Inspector

E. reporkl
@ Skyles

: = Parameters
Fields
YWariables

B

Scriptlets
Background
Title

Page Header

Detail
Column Footer

XTI IAG S

Page Foater

-
w7 Summary
S

Mo Daka

Zolumn Header

Last Page Fooker

Formatting Tools

[1] Template Inspeckar

Report Inspeckar
(1)) Report Problems

A Styles Library

= )

@'\ @\ I.ﬁ.gency FE LIP
3

|||||||||I||||1||||I||||?||

Classic template

TABLE_MAME
SF{TABLE_MAME]

"Page

5= Services Chrl4+5
Favotites Chrl4+3
Palette Chrl-Shift+5
Welcome to iReport
| Properties Ctrl+Shife+7
Oukpuk
Editar CErl+0
Processes
Close 'window CErl+in
Mazximize Mindow Shift+Escape
Indock Window Ale+shift+0
Zlone Docurment
Close &l Documents CErl-+ShifE+H
Close Other Documents
Documents. ., Shift-+F4

Reset Windows

E
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The Repository Navigator pane appears.

1 Jaspersoft iReport Designer 5.1.0

File Edit Yew Format Preview Window Tools Help

!‘:{:‘:é_':g |.l'_.i L:C < :I:—‘ ‘ J / Icsal
| Repository Navigator 4 X
|l B

&
Click the —I button to create a new server.

The JasperServer Plugin dialog box appears.
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| Repository Mavigator Al X| @ Prowider

J . | E‘.ﬂ Designer

MJaspEﬁerver Plugin
i

©);

1 L]

i

w2t JasperReports Server Access Configuration

~Server Information
]

IJasper Server Repository

JasperReports Server LIRL
Ihttp:,l',l'lu:u:alhu:ust:EDSZIjasperserverIservices,l'repu:usitu:ur';.f

—&ccount
Username Passwiord
jaSpEradmin shekckkokekakokkk

Zancel |

Enter values into the following fields for your JasperReports Server:
e ID of the server
You can enter any name of your choice. Enter a name that is meaningful.
e JasperReports Server URL
The default value for JasperReports Server URL is
http://localhost:8080/jasperserver/services/repository

If you are using the same URL for JasperReports, then keep the URL as is; otherwise, replace it.

e Username
e Password

Click Save.

Jaspersoft iReport Designer retrieves the information from the server. The Repository Navigator appears as follows.
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http://localhost:8080/jasperserver/services/repository

¥ 1aspersoft iReport Designer 5.1.0

File Edit Yiew Format Preview Window Tools Help

‘Q; ‘M By E ‘ B | ) [csareport _:_]||
| Report Inspector || Reposttory Navigator @ x| [ Welcome Window x| a4 ACti i jrxml x| [ Frovi jranl x|
J || B Designer XML ]Preview I|S elﬁ] 3 bilus====5=2=
3 o 1 2 3 4 S & 7 8 9 10 11
[+14] Jasper Server Repositary bt o oo T s Lo boccc oo Dot oo oo b s oo b oo oo Do oo Dl
- Analysis Components 3
([ Content Files =
B[ Data Sources 3
| Input data Types i
| Images
8= :j Provider Type Resource Pool Subscription Start Date  End Date
= o

- [

_ Interactive
| Samples
2] ACtiveSubscriptionByOrg
E @ ProviderSubcriptionReport
- Themes

new java.util.Date()

[}

1

3

=2
b becc e v becnc Do e Doccc b b bccc becccho

3

| Report Prablems Window:

| | iReport output

iReport console  Finished [ProviderSubcriptionReport. jrxmi] |

@ Locale: English {United States)
2 Time zone: Default

Report fill running time: 487! (pages generated: 1)

B Compiling to file... C:\U jasper
C ilation running time: 749!
@ Filling report...

& Viewing with JasperReports Viewer
Export running time: 3!

al

Define the Data Source for a Report

You must define the data source for a report. For previewing, the local data source is used, but to display the report

from the server, you must define a data source on the server as well.

1. Select the Data Sources folder in the Repository Navigator pane.

2. Right-click Add > Data Source.

The Data Source dialog box appears.
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[MDatasource | x|

Qg
ocH
LI Data Source

General | Data Source Details

Parent Folder [datasources

ID |

Mame |

Descripkion

4] | +]
Save | Cancel I

Enter values into the following fields for your data source:

e ID
For example, JRServer.
e Name
For example, SRServerDataSource.
e (Optional) Description
Click the Data Source Details tab.

If you select a JDBC data source, you can click the Import from iReport button to help provide these details. Select
the local data source that you specified during report design.
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mnataﬁuurce

g
oo
LI

Data Source

General [Data Source Details

Datasource T':.-'pelJDEC
~Settings

Diriver Iu:urau:le.jdbc.driver.DracIeDriver

LIRL debc:uracle:thin:@FreshWinOracle: 1521:C54

sername IESEILISEF

Passward I*******

i Import from ifepark

Saye Cancel

Click Save.

The list of reports in the Repository Navigator pane corresponds to the list that appears on the webpage.

Create a folder named CSA_Reports under the Reports folder.
Right-click the CSA_Reports folder.
Select Add — Report.

Enter the name, label, and description for the report.
Click Save.

Click Browse to browse to and select a .jrxml file (for example, ProviderSubscription.jrxml) and select it.
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This is the JasperReports report template file that was generated when you created the template.

Steps Main JRXML

1. Naming
2. Main JRXML
3. Locate Data Source

Locate the main JRXML file

(" From the repository

I Browse

{+ Locally Defined

|-erReportDesigns'l,ProviderSubcriptionReport.jrxml

Get source from current opened report

< Back Mext = Firiishy Cancel Help

Click Next.
Select a data source from the available data sources.

The following figure uses /datasources/CSA_Reports as an example data source.
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(M Reportunit wizard [ X|

Steps Locate Data Source
1. Maming
2. Main JRXML

3. Locate Data Source

Locate the Data Source

{* From the repository

Janalysisjconnections/Foodmart _'J Browse

/analysisfdatasources/FoodmartDataSourceJNDI &
/analysisfdatasources/SugarCRMDataSource
fanalysisfdatasourcesfSugarCRMDataSource JNDI

fdatasources/CSA_Reports

(" [fdatasources/IServerldbcDS
/datasources/IServer JNDIDS
/datasources/repositoryDS
/datasources/SugarFoodmartVDS v

< Back Mext = || Finish I Cancel Help

Click Finish.

The report is now available from the website.

« € [ localhost: 8052/ jaspe = fflow htm | ?_flowld=searchFlow

O JASPERSOFT @ Library Wview, Manage,

sosneradmin tner | Lo3 0.+ R F
= — E e e

Name Description Trpe Crested Date Modiied Date

ProviderSubcriptionkeport Report far ProviderSubeription cport Todsy Today

You can now preview the report.
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[ Jaspersoft iReport Designer 5.5.0

EBle Edt View Formst Preview Window Iodk Help

% |> o |l = 3
| Repository Navigator @ x| [ L4 ProvdersubcriptionRepart jraml x |
s [EB[@® Desgner | 1 [heven @@ @ 1 <> 0] (DEAQ Qi v &
2§ test
+ Analysis Components
Content Fles
B e iaxouasons Subscriptions by Provider
W 5erver INDI Data Source
§ Jasperserver Repositary SQL data source
) SugarCRM-Foodmart Virtual Data Source Access Point Provider Type Pool bscrij Start Date End Date
jc:] Input data Types
Images
System Properties
Reports https:/flocalhost:443  VMware vCenter RnD Pool Windows server subs ~ 2013-11-01 08: null
Interactive 00:00.0
Samples https:/ocalhost:443 VMware vCenter RnD Pool QA Subscription 2013-11-0108: null
Themes 00:00.0

https:/Nocalhost:443

VMware vCenter RnD Pool Snow White Program 2013-11-01 08:
00:00.0

null

http:/itest

VMware vCenter  Finance Pool Customer POC #156  2013-11-0108:

00:00.0

null

Audit Report Examples

This section includes some examples to see specific audit events by running queries on the RPT_AUDIT_EVENT_V

database view.

Login events

The following query will return all successful and unsuccessful login attempts in order starting from the most recent:

select * from rpt_audit_event_v where audit_classification = ’Authentication’ order by created_on

desc ;

Artifact creation, modification, and deletion

The following query will retrieve the audit event records for a design created with the name “Good Test Design,” which
was subsequently renamed and then deleted:

select created_on, modified_by username, user_organization_name,artifact_id, artifact_type,
artifact_name, audit_classification, audit_operation,description from rpt_audit_event_v where
artifact_id in (select artifact_id from rpt_audit_event_v where artifact_type='Service
Blueprint'and artifact_name='Good Test Design') order by created_on asc;;

The above query will return a result that is similar to the following example:

created_on modified
_by_
usernam
e

02-MAY-14 gooduse

02.17.58.258 ' r

user_ artifact_id

organizatio

n

_hame

CSA- 297e87c045968b

Provider 3f0145becd045b
Olea

artifact Artifa audit = Audit_
- ct_ - operati
type name  classif on

icatio

n
Service | Good | Creat | Create
Bluepri | Test e
nt Desig | Updat

n e
Delet
e

description

Artifact CUD
Successful
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02-MAY-14
02.20.16.597

02-MAY-14
02.20.46.360

baduser

baduser

CSA-
Provider

CSA-
Provider

297e87c045968b
3f0145becd045b
Olea

297e87c045968b
3f0145becd045b
Olea

Service
Bluepri
nt

Service
Bluepri
nt

Bad
Test
Desig

Bad
Test
Desig

Creat
e
Updat
e
Delet
e

Update

Creat | Delete
e

Updat

e

Delet

e

Artifact CUD
Successful

Artifact CUD
Successful

Note: Audit event data can be purged if desired by running the DB Purge tool. Refer to the CSA documentation for more

information.
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Send documentation feedback

If you have comments about this document, you can send them to docs.feedback@microfocus.com.

Legal notices

Warranty

The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”) are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or
editorial errors or omissions contained herein. The information contained herein is subject to change without notice.

Restricted rights legend

Contains Confidential Information. Except as specifically indicated otherwise, a valid license is required for possession, use or copying. Consistent with FAR 12.211 and
12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under
vendor's standard commercial license.

Copyright notice

© Copyright 2008 - 2018 Micro Focus or one of its affiliates.
Trademark notices

Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

RED HAT READY™ Logo and RED HAT CERTIFIED PARTNER™ Logo are trademarks of Red Hat, Inc.

The OpenStack word mark and the Square O Design, together or apart, are trademarks or registered trademarks of OpenStack Foundation in the United States and
other countries, and are used with the OpenStack Foundation’s permission.

Support
Visit the Hewlett Packard Enterprise Software Support Online web site at https://softwaresupport.softwaregrp.com.
This website provides contact information and details about the products, services, and support that Micro Focus offers.

Micro Focus online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to
manage your business. As a valued support customer, you can benefit by using the support website to:

. Search for knowledge documents of interest

. Submit and track support cases and enhancement requests
. Access the Software Licenses and Downloads portal

. Download software patches

. Access product documentation

. Manage support contracts

. Look up Micro Focus support contacts

. Review information about available services

. Enter into discussions with other software customers

. Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support contract.
You can register for a Software Passport through a link on the Software Support Online site.
To find more information about access levels, go to https://softwaresupport.softwaregrp.com/web/softwaresupport/access-levels.

To check for recent updates or to verify that you are using the most recent edition of a document, contact your Client Director.
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